Cross-Organizational Business Processes

INTEROPERABILITY

Issues and Concepts

Tools and Technology
This book includes a CD, with the complete set of training material of this course, i.e., PPT slides, the text of this book in .pdf, the ATHENA Curriculum, and the link to the ATHENA eLearning Platform where this course is available in eLearning style.
I. About ATHENA

ATHENA – Advanced Technologies for interoperability of Heterogeneous Enterprise Networks and their Applications - is an Integrated Project sponsored by the European Commission in support of the Strategic Objective “Networked businesses and government” set out in the IST 2003-2004 Work programme of FP6. Building upon an ambitious Vision Statement “By 2010, enterprises will be able to seamlessly interoperate with others”, ATHENA aims to make a major contribution to interoperability by identifying and meeting a set of interrelated business, scientific & technical, and strategic objectives. The ATHENA programme of work is defined for producing results that span the full spectrum of interoperability from technology components to applications and services, from research & development to demonstration & testing, and from training to evaluation of technologies for societal impact. In ATHENA, Research and Development is executed in close synergy and collaboration with Community Building, for ensuring that solutions to multi-disciplinary research challenges are of optimal industrial relevance leading to broad uptake by the end user. The ATHENA consortium currently comprises 19 leading organisations in research, academia, industry and other stakeholder communities including SMEs, working collaboratively in pursuit of a common set of objectives in interoperability. ATHENA is committed to creating a long term impact for advancing interoperability which is mainstream, inclusive and has critical mass. To this end, ATHENA is initiating an open, neutral and independent Enterprise Interoperability Centre (EIC) to which all stakeholders, in both private and public sectors, are invited to participate.
II. About the course

Business process management becomes more and more a source of competitive advantages and thus of strategic relevance. Moreover, current IT solutions enable companies to run business processes across several organizations. Nonetheless in order to run business processes across several organizations the IT systems have been integrated very tight. Thus has limited organizational flexibility to change partners within a supply chain net or to react properly. Building on ATHENA's vision, “by 2010 enterprises will be able to seamlessly interoperate with each others” this course is dedicated to issues and concepts regarding cross-organizational business processes. This booklet will introduce a methodology how organizations can properly design cross-organizational business processes without revealing internal and strategic issues. This methodology will show how existing cross-organizational business processes can be improved, new business processes and partnerships be created while avoiding the pitfall of tight IT integration. Furthermore, approaches are introduced that shows the reader a path how such a methodology can be implemented in the current ICT landscape of the organization. Furthermore it is shown how the physical infrastructure of cross-organizational business processes may look like to achieve seamless interoperability.

After the introduction into the theoretical concepts Part B brings in new tools and technologies that enable above developed concepts. Part B serves as a guide on how to use those tools and techniques.

III. Who should read that booklet

This booklet is very important for everybody in academic and industry who’s profession is concerned with business processes and business process management across organizational boundaries. Inventing new business processes and having the technology to efficiently implement those business processes can be a new source of innovation and competitive advantage. Therefore, having the knowledge of the new research results can be a source of value creation and gaining competitive advantages for your organization.
**IV. Table of Content**

I. About ATHENA ........................................................................................................................... 3  
II. About the course ........................................................................................................................ 4  
III. Who should read that booklet .................................................................................................... 4  
IV. Table of Content ....................................................................................................................... 5  
V. List of Tables ........................................................................................................................... 10  
VI. List of Abbreviations ............................................................................................................... 11  
PART A ....................................................................................................................................... 12  
1. Introduction into Business Process Management...................................................................... 13  
   1.1. Business Process Management in a Nutshell ........................................................................ 16  
   1.2. The Functionality of the Business Process Layer .................................................................... 17  
   1.3. ATHENA builds on current BPM approaches and enriches them ......................................... 19  
2. Business Example.................................................................................................................... 21  
   2.1. Participants and Processes within the Procurement Process ............................................. 22  
   2.2. eProcurement Scenario – Behavior at Runtime ................................................................. 23  
   3.1. Analysis of Requirements for cross-organizational business processes ......................... 25  
   3.2. View Approach for CBP modeling...................................................................................... 26  
   3.3. Selected Process Visibility................................................................................................. 28  
   3.4. Modeling Procedure........................................................................................................... 29  
      3.4.1. CBP Modeling Inside Out ............................................................................................... 30  
      3.4.2. CBP Modeling Outside In ............................................................................................... 31  
4. Issues and Concepts for Modelling of CBP's ............................................................................ 32  
   4.1. Modeling Requirements .................................................................................................... 33  
   4.4. Athena CBP Modeling Approach ....................................................................................... 38  
5. Execution and Monitoring Issues and „High Level Architecture“ ................................................ 39  
   5.1. Executing issues ............................................................................................................... 40  
   5.2. Monitoring Issues .............................................................................................................. 41  
   5.3. CBP Enactment Architecture – the big picture ................................................................... 42  
      5.3.1. Interface components ..................................................................................................... 43  
   5.5. Physical Architectures....................................................................................................... 46  
      5.5.1. Peer to Peer Architecture ................................................................................................ 46  
      5.5.2. Mediated Architecture .................................................................................................... 47  
6. Detailed Architecture................................................................................................................ 49  
   6.1. View Process Engine ........................................................................................................... 50
V. List of Figures

Figure 1 – Layers of a BPM solution ........................................................................................................ 16
Figure 2 - BPMS Functionality .............................................................................................................. 18
Figure 3 - Scenario ................................................................................................................................ 23
Figure 4 - Three types of Processes .................................................................................................... 27
Figure 5 - selected process visibility .................................................................................................. 28
Figure 6 - CBP Example ...................................................................................................................... 29
Figure 7 - Modeling CBP Inside Out .................................................................................................. 30
Figure 8 - CBP Modeling Outside In .................................................................................................. 31
Figure 9 - Outside in Approach .......................................................................................................... 31
Figure 10 – Three Level Modeling Approach ................................................................................... 35
Figure 11 - Evaluation of State of the Art Approaches ...................................................................... 37
Figure 12 - CBP Modeling Approach .................................................................................................. 38
Figure 13 - Enactment Architecture the Big Picture ........................................................................... 42
Figure 14 - Internal Company Architecture ........................................................................................ 45
Figure 15 - Peer to Peer Architecture ................................................................................................ 46
Figure 16 - Mediated Architecture ...................................................................................................... 47
Figure 17 - View Process Engine ........................................................................................................ 50
Figure 18 - Architecture for Direct Application Integration ............................................................... 52
Figure 19 - Internal Engine Integration .............................................................................................. 54
Figure 20: Screenshot Setup Wizard .................................................................................................. 59
Figure 21: Introductory Business Example – relationships between Private Process, View Processes, CBP .................................................................................................................. 60
Figure 22 - Screenshot Maestro ........................................................................................................... 61
Figure 23: Screenshot Layout Tools .................................................................................................... 63
Figure 24: Screenshot Name Private Process ....................................................................................... 64
Figure 25 - Workflow schema example ............................................................................................... 67
Figure 26 - Additional workflow information ..................................................................................... 68
Figure 27 - Maestro menu ................................................................................................................... 68
Figure 28: Global Data Repository ....................................................................................................... 69
Figure 29: Screenshot Workflow relevant data ................................................................................... 69
Figure 30: Assigning partners to a process ......................................................................................... 70
Figure 31: Adding new Partners .......................................................................................................... 71
Figure 32: Select Private Activities ...................................................................................................... 72
V. List of Tables

Table 1 - Participants within eProcurement Scenario ............................................................... 22
Table 2 - Subprocesses within Scenario .................................................................................. 22
### VI. List of Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARIS</td>
<td>Architektur Integrierter Informationssysteme</td>
</tr>
<tr>
<td>ATHENA</td>
<td>Advanced Technologies for Interoperability of Heterogeneous Enterprise Networks and their Applications</td>
</tr>
<tr>
<td>BPM</td>
<td>Business Process Management</td>
</tr>
<tr>
<td>BPMS</td>
<td>Business Process Management System</td>
</tr>
<tr>
<td>BPR</td>
<td>Business Process Reengineering</td>
</tr>
<tr>
<td>C.P.</td>
<td>Compare</td>
</tr>
<tr>
<td>CBP</td>
<td>Cross-Organizational Business Process</td>
</tr>
<tr>
<td>EAI</td>
<td>Enterprise Application Integration</td>
</tr>
<tr>
<td>eEPC</td>
<td>Extended Event Driven Process Chain</td>
</tr>
<tr>
<td>EIC</td>
<td>Enterprise Interoperability Center</td>
</tr>
<tr>
<td>EPC</td>
<td>Event Driven Process Chain</td>
</tr>
<tr>
<td>ERP</td>
<td>Enterprise Resource Planning</td>
</tr>
<tr>
<td>ICT</td>
<td>Information and Communication Technology</td>
</tr>
<tr>
<td>PA</td>
<td>Private Activity</td>
</tr>
<tr>
<td>SCM</td>
<td>Supply Chain Management</td>
</tr>
<tr>
<td>UML</td>
<td>Unified Modeling Language</td>
</tr>
<tr>
<td>WSBPEL</td>
<td>Web Service for Business Process Execution Language</td>
</tr>
</tbody>
</table>
PART A

Interoperability
Issues and Concepts
1. Introduction into Business Process Management
In recent years business processes and business process management has become increasingly important for enterprises to gain competitive advantages. Business Process Management is about modeling, executing, managing and analyzing end-to-end processes. Business process management is not a new approach rather views and agendas around business process management have changed. There are mainly three important waves regarding business processes management. The first wave traces back to the 1920’s. It was dominated by Frederic Taylor’s theory of management where processes where implicit in work practices and not automated.\(^1\) The second wave can be found in the past decade. The rise of vendor’s off the shelf ICT systems like ERP, CRM, SCM and other solutions enabled organizations to automate their business processes. Organizations implemented best practice business processes and achieved high business process efficiency. The third wave can be identified at present. While the solutions of the past decade offered rather stiff business processes current solution make it possible organizations to create and implement individual business processes. This technological achievement offers great opportunities for organizations to gain competitive advantages by designing and deploying unique business processes. Despite, it also displays a renaissance for business process modeling. In the past business process modeling has been perceived as an additional step in business process management that was less beneficial and in particular incompatible with tight delivery schedules. However, much progress has been achieved regarding business process modeling and especially modeling business processes and converting them automatically into executable code seems a major breakthrough. This achievement dramatically increases efficiency of developing new business processes and reduces implementation to a matter of days. Also ATHENA has caught and builds upon this approach. Nonetheless current concepts lack that they can only be applied within company boundaries. Therefore one of the tasks within ATHENA was to research interoperability issues and concepts regarding cross-organization business processes.

### Examples of Cross Organizational Business Processes

Some business scenarios may show the reader why it is beneficial to own more efficient cross-organizational business processes. Boeing designed its 777 airliner “in Cyberspace” by electronically sharing its CAD/CAM design tools and business processes with engineers, customers, maintenance personnel, and suppliers. Through efficient process collaboration Boeing aims to deliver a plane in eight to twelve month instead of almost two years, and the company expects to deliver 620 airplanes a year, up from 228 in 1992.\(^2\) The potential of more efficient business processes can also be seen within the area of logistics – the processes by which goods

---

\(^1\) Cp.: Smith, 2002, p.18  
\(^2\) Cp.: Smith, 2002, p. 122
move from enterprise to enterprise or enterprise to customer. Globally, enterprises spend about $2 trillion a year on these services. 40% of those dollars pay for administrative services, or paperwork. I.e. transoceanic shipment can require up to 26 documents. If the efficiency of those cross- organizational administrative business processes could be enhanced by 50% it would result in annual savings of $400 billion.³

³ Cp.: Champy 2002, p. 1
1.1. Business Process Management in a Nutshell

As already stated Business Process Management is about modeling, executing, managing and analyzing end-to-end processes. Furthermore it is important to mention that business process management has to be done at the level of business design. This means that business processes will be designed focusing solely on business requirements and needs. Business Process Management includes:

- methods
- techniques
- tools and
- services

for processes modeling and process-oriented system design. Furthermore business process management covers the entire lifecycle of a business process. The life cycle of a business process embraces

- modeling,
- execution,
- monitoring,
- analysis and optimization.

Figure 1 – Layers of a BPM solution
Currently there are several solutions that support business process management across the entire business process lifecycle. The key objective of those BPM solutions is to separate the process logic from business applications and manage it through business process management technology. In order to achieve such a separation those solutions can be described through different layers. Figure 1 above shows the resulting separation of different logical layers. A separation of applications, user interfaces and databases is state of the art in information systems. In addition to that BPM adds an additional layer and separates the process logic from the application components. Therefore this BPM layer is responsible for linking existing application functionality into long running processes.

What are the benefits of that additional BPM layer?
The interested reader might ask what might be the benefit of such an additional layer and separating Business Process Management as an independent function? By separating Business Process Management as an independent function, applications can be designed around existing processes. Thus one can take advantage of shared business logic rather than reinventing and recoding it for each application. Application components only execute single functionality and have minimal awareness of one another and minimal awareness where and how they are being utilized in the BPM layer. If changing business needs lead to an adoption of process flows, this can be easily handled with the BPM layer and does not result in changes to the original application code. Single applications and data are the bricks to build business processes. The mortar comes from the process logic. Summarized having the bricks and mortar enables companies to create individual business processes to gain competitive advantages.

1.2. The Functionality of the Business Process Layer

The previous chapter explained, what business process management is about and that business process management should embrace and support the entire business process life cycle. Furthermore it has been explained that BPM is realized through an additional layer in order to separate process from application logic. The solutions that support business process management are called business process management system (BPMS). BPMS is a category of software that allows designing a business process, execute it and manage it in a unified whole.

This chapter will now dive deeper into the process layer and especially examine which functionality is included into such a BPMS (see also figure 2).

At design time process models are created using Business Process Modeling Tools. A Process model is the prescription of execution of a business process. It can be considered as a blueprint
that describes the order in which tasks are invoked at runtime. In general, four different kinds of process models can be distinguished:

- fully predefined (static BPM),
- not predefined (ad-hoc BPM)
- partially predefined (flexible BPM), or
- include other organization’s entities (cross-organizational BPM).

A business process may not only contain the order in which tasks are invoked. Apart from that, a business process model can be enhanced by relevant data and documents or organizational responsibilities. Those process models are designed within a Process Modeling environment which is part of the BPM functionality. Those process models are exported into a process repository from where they are instantiated and executed by the Process Enactment Engine. The process enactment engine utilizes the process model in conjunction with BPM-relevant application data to take the overall business process from one state to another. Furthermore it will allocate activities to right participants, at the right time, with right resources, and in the right order.

The Monitoring, Viewing, and Analysis tool supports effective and efficient execution of business processes and build process-aware user interfaces. Another functionality that is closely related to business process monitoring is the Administrative Tool. Those users with administrator role have access to Administration Tools to ensure smooth operations of overall BPM environment and to proficiently manage exceptional situations.

Different kinds of participants that carry out the work / activities assigned by the process enactment engine are consolidated into one block called Participant Management.

The Worklist Handler allocates activities to people to work on. It achieves this functionality through work list user interfaces using organizational structures and roles.

The Application Handler interacts with business components associated with activities whether or not they are allocated to people.
The process enactment engine makes use of Event Handlers to loosely link up with business objects and other external participants.

The functionality of a BPMS offers several advantages. One of the biggest advantages is the transformation of business process models into code that can be processed by the process enactment engine. For this functionality Gartner states that “Enterprises should begin to take advantages of explicitly defined processes. By 2005, at least 90% of large enterprises will have BPM in their enterprise nervous system (0.9 probability). Enterprises that continue to hard-code all flow control, or insist of manual process steps and do not incorporate BPM’s benefits, will lose out to competitors that adopt BPM.”

1.3. ATHENA builds on current BPM approaches and enriches them

The BPMS functionality shown in figure 2 and explained above has received increasing recognition for company internal application and systems development. Business process management systems have demonstrated the applicability of this concept within the boundaries of the enterprise. ATHENA researchers envisage that this concept holds a significant potential in the cross-organizational context as well. The Key idea behind the cross-organizational business process research in the ATHENA project is therefore to achieve interoperability of enterprise applications at business process level. A cross-organizational business processes represents a process that is executed by multiple business process management systems in different organizations. In past few years, the use of BPM technology in integrating cross-organizational applications has been investigated. The effective deployment of cross-organizational business processes comes up with several challenges:

- Stand Alone Business Process Applications
  *How to do the integration of applications that are not supported by a BPMS?*

- Business processes in organizations
  *How to integrate business processes within organizations that are preexisting and moreover have been defined independently?*

- User Integration

_____________________

a Smith, 2002, p. VI
How to integrate different view points of users of different organizations within a cross-organizational business process

Furthermore, collaborative business process management needs sophisticated and fine-grained communications and messaging technologies for deployment and enactment. It has been stated above that business processes are becoming more and more a source of strategic differentiation in order to gain competitive advantages. This in turn makes it necessary and very important to protect the design of processes that are critical to the organization while still being able to expose required information to the public.

To address these challenges researchers within ATHENA have conducted an extensive analysis of various business scenarios and best practice approaches. Based on this evaluation researchers have consolidated a list of high level user requirements that comprise desired functionality and tool support for modelling, managing and executing cross-organizational business processes. Those requirements and issues can be divided into four different categories.

- Privacy / Visibility,
- Modelling of processes,
- Execution and
- Monitoring.

The subsequent parts of the booklet will follow this division and present requirements and issues as well as concepts developed to meet those requirements.
2. Business Example
In this section a business example is introduced that will be used throughout this course to illustrate the interoperability issues and concepts. The business example addresses an eProcurement scenario for producing and selling furniture and is taken from the furniture industry. First the involved participant are introduced, then the processes as well as the goal. First the scenario will be described from a static perspective and then the scenario is explained at runtime.

2.1. Participants and Processes within the Procurement Process

Within the eProcurement Scenario there are four different participants:

<table>
<thead>
<tr>
<th>Participant</th>
<th>Role in Scenario</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retailer</td>
<td>Offers furniture of different manufactures in his job</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Produces Furniture</td>
</tr>
<tr>
<td>- Sales</td>
<td>- Interacts with Retailer and handles orders</td>
</tr>
<tr>
<td>- Procurement</td>
<td>- Interacts with suppliers</td>
</tr>
<tr>
<td>Supplier</td>
<td>Provides material that is needed to manufacture furniture</td>
</tr>
</tbody>
</table>

Table 1 - Participants within eProcurement Scenario

Within this scenario we consider two different subprocesses:

<table>
<thead>
<tr>
<th>Process</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selling Process</td>
<td>Contains all necessary tasks in which the retailer orders furniture at the manufacturers sales department for an interior decoration project at one of his customers</td>
</tr>
<tr>
<td>Procurement Process</td>
<td>Contains all necessary tasks in which the manufacturer orders material to produce furniture.</td>
</tr>
</tbody>
</table>

Table 2 - Sub processes within Scenario
2.2. eProcurement Scenario – Behavior at Runtime

The retailer has received an order from one of his customers for an internal decoration project. In order for the retailer to fulfill the customer order he needs to order the furniture himself. Therefore, the retailer sends a Request for Quotation to the sales department of the manufacturer. The manufacturer processes the request and sends back a quotation with an offer for the furniture. The retailer evaluates the quotation and decides to place an order with the manufacturer. After the manufacturer receives the order it is checked whether enough material is on stock. The procurement process is triggered if the sales department of the manufacturer determines that new material has to be ordered to ensure that ordered furniture can be produced. The procurement department selects an appropriate supplier for the required material from its local database. Then a Request for Quotation is sent to the supplier.

The supplier processes the request and sends back a quotation with an offer for the material. The procurement department checks the quotation and sends an order to the supplier. The supplier processes the order, sends an order confirmation to the manufacturer and starts producing the material. After the manufacturer has received the order confirmation he sends an order confirmation to the retailer.

**Goals of the Manufacturer:**

It is now the goal of the manufacturer to improve the integration of sales and procurement process in order to reduce the order fulfillment time for the retailer. Furthermore, the manufacturer wants to be able to integrate seamless with different suppliers and thus be able to switch suppliers more flexible.
3. Privacy and Visibility Issues and Concepts
Business processes become more and more important in order to achieve competitive advantages. Thus makes business processes also more critical to organizations. However, cross-organizational business processes do require partners to make certain information visible to the public. Therefore it is the objective of this section to present analyses and concepts to address privacy and visibility issues.

3.1. Analysis of Requirements for cross-organizational business processes

One of the first steps in designing cross-organizational business processes is to analyze and describe requirements for cross-organizational business processes.

Conceal details of the business process
The successful designing of CBPs requires that partners link their existing internal processes and resources to achieve an agreed cross-organizational business process. That means that internal private processes of different organisations have to be linked in order to create long running end-to-end processes. However, it can not be expected that enterprises will publish all details of business processes especially if those processes are of strategic relevance for the business. Thus enterprises must have the ability conceal details of their business processes to preserve autonomy and privacy.

Selectively Exposition of Information
Each company has to be able to selectively expose or hide information about their internal processes, whilst still being able to act in a cross-organizational business process. Referring to the eProcurement scenario when the manufacturer receives the RFQ, there are several internal departments involved in order to create the quotation. However, the internal processing of the quotation is not visible to the retailer that just deals with the sales department. The level of exposure can vary, and contracts with partners as well as trust building may lead to revealing more internal information as the business relationship develops.

Ability to adapt in different scenarios
A particular interaction may require involved partners to adapt for the purpose of the communication. This adaptation can not necessarily be reflected in the partners' private (internal) business processes without inflicting their ability to interact with other partners in a different context. Imagine the manufacturer in the eProcurement scenario wanting to collaborate with various retailers and needs to adapt. It will be its goal to run the same internal process. In order for the manufacturer to adapt to different requirements of the retailers the manufacturer may only change its process-
oriented interface. The process view approach has been developed within ATHENA and matches the above elaborated requirements.

3.2. View Approach for CBP modeling

Based on above requirements researchers from ATHENA have developed the view approach. The process view approach provides a concept to selectively expose internal information and hide business critical ones. Furthermore it is sufficient to interweave processes into cross-organizational business processes.

The concept encompasses private processes out of which view process views can be modeled. Process views represent an abstraction of private processes and do not contain any private confidential information anymore but are still sufficient to set up a CBP model. The entire concept is explained in more detail below.

Private Process

Private business processes are internal processes and to a specific enterprise. Private processes do contain either confidential information or the tasks within those processes are business critical. Therefore, private processes are not designated for collaboration or any publication purpose.

View Process

A view process represents an abstraction of a private process model and shows the outside world what an enterprise has to offer. The main difference to a private process is that several graphical notations can be merged into a single one. For example several business critical tasks of a private process can be merged into one view task of a view process. This allows enterprises to hide private and confidential information to the outside world. The abstraction provides also another benefit. From each private process 1…n process views can be abstracted. As shown in organization B different view processes can be created as an abstraction from the same private process. This allows partners to keep their internal processes static while still being able to interact with different partners in a different context.

Since view processes represent an abstraction of a private process they cannot be executed within an ICT system. Instead view processes outsource their implementation to private processes. Therefore process views have to be tightly bound into their corresponding private process.

\[^5\text{Cp.: Schulz, 2004, p. 10}\]
Cross-Organizational Business Processes

The view processes are linked up into a cross-organizational business process. The CBP shows the specific collaboration between two and more partners. As it is shown in Organization B, one view process can be part of different or just one specific CBP.

Figure 4 - Three types of Processes
3.3. Selected Process Visibility

One of the requirements for a cross-organizational business process was to selectively expose information. Without the selected process visibility the tasks of the private processes of the partners would be linked up directly in the cross-organizational business processes. Thus partners directly expose the tasks from their private processes to the CBPs.

Applying the concept of view processes allows the partners to explicitly decide which tasks of their private processes are exposed. That means that several tasks in the private process are merged into one task in the view process. The merge of several private tasks into a view task represents an abstraction. Thus partners cannot recognize which private tasks are performed, only view tasks are visible. Then, these view tasks are linked up in the cross-organizational business processes.

The following example should foster the understanding of the above introduced concept. The CBP example (see figure 6) focuses on the interaction between a manufacturer and a supplier.
The manufacturer defines a view process. In this view process the manufacturer hides the selection of suppliers and only exposes one task named “create RFQ”. He also merges the tasks “compare quotation” and “create order” into the view task “Create Order.”

The supplier also defines a view process in which he defines view tasks hiding the internal processing of the RFQ (“calculate production plan” and “create quotation”) and the processing of the order (“receive order”, “send order response”, “manufacture material”).

In the last step the view processes are combined into the cross-organisational business process. The arrows show how the tasks of the CBP are linked to the view tasks and the tasks in the private process.

3.4. Modeling Procedure

It is also very important to explain how those cross-organizational processes can be modeled. There are two major approaches for the creation of CBPs, one named inside-out and the other outside in.

Figure 6 - CBP Example
3.4.1. CBP Modeling Inside Out

With the inside out approach partners do model view processes out of private processes. Then those view processes are interwoven into a cross-organizational business process. The inside out approach is shown in the figure below.

Figure 7 - Modeling CBP Inside Out
3.4.2. CBP Modeling Outside In

The other approach is to model CBPs outside in. That means that partners start identifying a common picture of the CBP model. Then each partner will create its view processes accordingly. As a last step, each partner would have to define the necessary private processes.

A third scenario is that of one partner starting with its private processes and offering a view process to its partners. The partners can use this process based interface to link it to their internal processes via process views. This would conform to an inside-out approach for one partner and an outside-in approach for the others. Which procedure is suitable is depending on existing partner processes and the relationship between the different organizations.
4. Issues and Concepts for Modelling of CBP’s
In this section concepts and issues regarding modeling of CBP’s will be discussed.

4.1. Modeling Requirements

It is necessary to consider some modeling requirements to establish cross-organizational business process modeling and offer it to partners and customers as an opportunity to organize collaborations:

- **Offer a collaborative and integrated CBP modeling framework**
  It is necessary to offer one collaborative CBP modeling framework consisting of the best of breed techniques for different levels of modeling. An integrated framework means that it should incorporate business aspects and requirements for modeling as well as technical ones. It is very important that business and technical aspects are integrated in this framework.

- **Common Collaborative Environment**
  Users need a common environment where to interact and share context and state information related to their business processes.

- **Modeling of CBP Business Context**
  The modeling of the underlying business context should be supported. The business context describes an operational business situation, including its goals, objectives, expectations, and problems. However, not all aspects of models at the business context level will be executable (e.g., meetings, problem escalation up the organizational hierarchy, physical transport of materials).

- **Support for Modeling at the CBP Level**
  The CBP design level must support conceptual specifications for the business level. Therefore, they must be highly suitable for business users, have a sufficient expressive power, and a clear (formal) semantics to avoid modeling ambiguities and errors.

- **Support for modelling at the CBP execution level**
  This level is transformed out of the CBP design level. Its purpose is to demonstrate the correctness of the design model with respect to the implementation platform.

- **Support of efficient CBP assembly**
  Support of efficient CBP assembly deals with a mechanism for the assembly of CBPs through process components from private and public processes. A modelling language must be able to...
describe the CBP interfaces, especially the relevant information within the process interfaces, so that the CBP can run properly. Also input and output flow within the CBP and at each partner has to be represented. Within the modeling framework, an efficient CBP assembly has to be supported. This deals with a mechanism for the assembly of CBPs through process components from private and public processes.

Based on the requirements developed above in the following we present the three level CBP modelling approach developed in ATHENA. The approach combines two modelling methods, the process view approach and an approach addressing the need for modelling at different design levels.

4.2. Three Level Modelling Approach

Modeling a business process and having directly the implementation of that business process is a great vision. However, researchers from ATHENA follow a more differentiated approach. Usually different user groups and modelers are involved into business process modeling. Those different user groups have different perspectives and needs reflected in the use of different modeling languages and tools. E.g. a model that is meant to be for the IT–specialist is probably difficult or cannot be understood from business analysts. Also, the business analysts may require having a business process model that contains physical tasks like truck drives from A to B. Such physical tasks cannot be implemented within an ICT system. Therefore in order to respond to those different needs and requirements of different involved users three different levels of business process modeling are suggested.

Business Level
Processes at business level are computational independent processes. Computational independent means that those processes are designed regardless if they can be implemented or executed within an ICT system. That means especially that those models can contain physical activities. Furthermore those process models depict a business process in the context of the entire enterprise. Those process models include additional relevant information for business processes, i.e. organizational responsibilities for a business process. This additional information is of high relevance for the business use and for the business analyst.

Technical Level
This level represents a cut-out of business processes. All activities represented at this level are implementable within an ICT system. Non ICT implementable activities are replaced as well as not necessary items like organizational responsibilities. Moreover message exchange between single
implementable activities may be modeled. However, the control flow of such a technical business process is still modeled in a platform independent manner, which supports the reuse of models.

**Execution Level**

At the execution level a business process is modeled in a concrete language of an execution engine. It is furthermore extended with software application system specific information, e.g. concrete message or data formats. The most famous and widely accepted modeling standard at this level is WSBPEL.

The entire approach is depicted above. The differentiation into these levels is closely related to the different types of models used in model driven architecture. Those levels are named computational independent models, platform independent models, and platform specific models. Within Athena’s Project A2 envisaging cross-organizational business process types and levels have been adjusted to a rather process orientation.

The multi level modeling approach is of high relevance for the practical use and is able to enjoy popularity, since it responds to the different needs and requirement of users.
4.3. State of the Art Approaches

A survey has been conducted about several state of the art approaches that deal with CBP modeling and enactment. Below you can find a list of approaches that represent a standard respectively standard proposals or are widely used within the business world:

- Event-Driven Process Chains (EPC)
- Integrated Enterprise Modelling (IEM) method
- SAP Business Scenario Maps
- Business Process Definition Metamodel
- Unified Modelling Language
- ebXML
- RosettaNet
- Business Process Modelling Language
- XML Process Definition Language
- Web Services Business Process Execution Language / Web Services Choreography Definition Language

However as a result of the survey, none of those standards is able to meet all requirements that have been introduced and explained earlier. For example take BPEL. BPEL is a highly popular standard and BPEL models can be executed by a process engine. Nonetheless, BPEL models are hard to understand from business analysts and are not always sufficient to represent a process from the business perspective.

Summarized, by looking at the different strength and weaknesses of the different approaches in terms of which requirements they fully or partially support the following can be concluded:

**Sufficient support for CBP assembly in most of the languages:**

We observe sufficient support for representing information flow between different partners in most approaches, except RosettaNet which has its main focus on process descriptions.

**Insufficient support for modeling of process abstraction and linking up internal processes to CBPs:**

Even though CBPs can be modeled and interfaces between the partners can be specified, we observe a shortcoming in explicitly linking up internal processes to CBPs. None of the discussed approaches offers a suitable mechanism to link up private processes into CBPs, enabling information hiding at the same time.
Need for a collaborative and integrated modeling framework comprising all levels of abstraction:

Taking into account the evaluation of languages concerning the requirements of supporting business context, the CBP design level and the CBP execution level, we observe that each language, standard and tool has a strength in either of those modeling levels.

If one aligns those state of the art approaches with the three level modeling approach that has been proposed by ATHENA researchers it results within the following figure:

![Figure 11 - Evaluation of State of the Art Approaches](image)

- EPC, IEM/UEML, Business Scenario Maps
- BPDM/BPMN, UML, ebXML, RosettaNet, BPML
- WS-BPEL/WS-CDL, XPDL, UML

Figure 11 - Evaluation of State of the Art Approaches
4.4. Athena CBP Modeling Approach

Regarding CBP modeling, different user groups are involved. User groups may range from business analysts to technical domain experts. All user groups have different requirements regarding the business process model and their requirements are reflected in the different modeling method.

Within ATHENA researchers have developed a CBP modeling framework in the form of a matrix. The different levels on which CBP modeling is performed (business level, technical level, implementation level) are represented on the vertical axis. On the horizontal axis the different model types of the process view concept are shown. At each intersection of a vertical and horizontal axis, one can identify a possible process model to capture tasks and relationships of cross-organizational interactions. Thus it is ensured that all relevant perspectives on CBP models as well as the processes required for the view concept are properly captured and modeled.

Furthermore, the modeling method should also allow selectively hiding internal information while offering a mechanism to expose CBP relevant information.

Within ATHENA researchers have developed a CBP modeling framework in the form of a matrix. The different levels on which CBP modeling is performed (business level, technical level, implementation level) are represented on the vertical axis. On the horizontal axis the different model types of the process view concept are shown. At each intersection of a vertical and horizontal axis, one can identify a possible process model to capture tasks and relationships of cross-organizational interactions. Thus it is ensured that all relevant perspectives on CBP models as well as the processes required for the view concept are properly captured and modeled.

However, this approach would actually require three different kinds of process models. Therefore transformations between the different modeling levels are necessary. Between the business level and the technical level transformation can be executed semi-automatically. Between the technical level and the execution level they can be automated.
5. Execution and Monitoring Issues and „High Level Architecture“
This chapter presents issues regarding execution and monitoring of cross-organization business processes. Furthermore a high level architecture will be illuminated in order to enact cross-organizational business processes.

5.1. Executing issues

First some issues and requirements regarding the execution of cross-organizational business processes are discussed.

- **CBP Collaboration Environment for operating CBPs**
  Architecture must support the CBP collaboration to observe, regulate (incl. change), and execute (send, receive and broker), the running CBPs. Architecture must support both passive and active execution of CBPs

- **Different interoperability strategies and means**
  CBP partners must be able to choose among different internal architecture alternatives

- **Notification to different business (work) tools**
  Functionality to send an e-mail or sms to a human participant in case of critical events should be provided

- **Authentication, access control, and system scopes**

- **Multi-cast interactions**
  Support for more complex interactions between collaborators than just binary interactions is required

- **Automatic transformation of business documents**
  Automatic transformation of business documents in the data-interchange between CBP partners is needed. The architecture must use schema definition mechanism to support the interchange

- **Constraints and quality of service parameters**
  Capture and consider physical operational constraints (such as message persistence and re-polling of requests) and contractual aspects of collaborations between parties in a CBP
- **Dry runs, simulation, and animation of CBPs to validate business processes before deployment**

- **Alternatives for building blocks of the enactment architecture:**
  Regarding the building blocks of the enactment architecture for execution of CBPs several alternatives could be considered. Distributed execution approaches as well as centralized approaches should be evaluated. The enactment architecture also needs to take into account that CBPs itself are not executed; only the private processes and the exposed views. Furthermore should the building blocks dealing with CBP modelling be clearly separated from the building blocks dealing with the execution of CBPs.

- **Scalable enactment architecture**
  The enactment architecture should also be scalable in terms of adaptability depending on the size of the enterprise and the number of running process instances.

- **Integration of different internal realizations of processes**
  The enactment architecture for the execution of CBPs should integrate different internal realizations of processes, including services, legacy systems, and various applications (cp. Figure 3). It should support interoperability of enterprise applications at business processes level.

- **Advanced issues such as dynamic execution / behaviour of a sub processes or exception handling / undo and redo of CBPs**
  Advanced issues that should be addressed are for instance, dynamic execution / behaviour of a sub process depending on the context, ability to execute “incomplete” CBPs, and Exception handling / undo and redo of CBPs.

5.2. Monitoring Issues

The other issue is dealing with the monitoring of a cross-organizational business process. Monitoring of cross-organizational business processes is very ambitious. On the one hand enterprises must be able to track the progress and the status of processing of their partners. This enables partners to react properly in case one of the partners is temporarily unable to perform his tasks. On the other hand, while publishing information about the status of the process, details about the process must be hidden. For instance the furniture manufacturer would wish to track the progress of his order. However, the status of encapsulated private processes and according private activities shall not be revealed to the partner.
Regarding monitoring issues, it is necessary to provide information about the status and progress of process while still being able to reveal private activities.

5.3. CBP Enactment Architecture – the big picture

So far several issues regarding the execution and monitoring of cross-organizational business processes has been discussed. Those issues do now serve as the foundation in order to develop a CBP enactment architecture. First, a big picture regarding the enactment architecture will be given and then this architecture will be refined and several details will be discussed.

The architecture shall build upon the ATHENA CBP model. In order to sufficiently protect the privacy of internal processes view processes have been introduced as an abstraction. Then again view processes were used in order to design CBPs. The guiding principle for the architecture is that it must allow visibility of processes but is still being able to protect internal privacy. Based on the guiding principle there are three main building blocks for the CBP architecture.

![Figure 13 - Enactment Architecture the Big Picture](image-url)
Referring to the figure above one can identify three major building blocks. Those are

**Company internal components**
Company internal components contain all building blocks which are encapsulated inside the company. Those components are not accessible by partners. This building block contains all components which refer to modeling and execution of private processes or the invocation of private processes.

**CBP components**
The CBP components are accessible to all partners. Those represent the information that has to be shared between partners in order to define and execute CBPs. They can also contain information that is necessary to monitor and analyze the CBP execution if this is required in a particular business scenario.

**Interface Components**
The interface components link company internal components with CBP components. Those represent information that is published by the companies in order to take part in CBPs, for instance view processes of the partner’s private processes.

After having described the three major building blocks each building block will now be refined. However, the company internal components will be considered as a black box. The main reason is that this description should be used on a generic level where the definition should be independent from a partner’s specific landscape. Therefore in the following section the interface and CBP components will be explained in further detail.

**5.3.1. Interface components**

While taking a closer look into the interface components one encounters the following components:

**Enactment Engine for View Processes**
An enactment engine is necessary that is which is responsible for the executing of view processes that make up the CBP. The enactment has three major tasks. First, this engine executes the process views that are part of the overall CBP instance. The enactment engine also communicates with the company internal private processes. Thus by executing view processes the enactment engine is also responsible for instantiating private processes. The third task is to handle the communication meaning to send and receive messages between different partners.
View Process Repository
As the name already indicates it is the process view repository’s task to store view processes. This repository might be separated from a private process repository as it may already exist.

Event and Document Correlation
The event and document correlation handler is responsible to identify the CBP instance to which an incoming message belongs. It has two different functionalities. First an incoming message will be mapped to a process instance and thus can be assigned to a current process. The second function is a semantic document mapping. This function maps incoming messages into a format that the partner is able to understand. This functionality furthermore maps outgoing messages into a format that is appropriate for the partner to be understood.

5.3.2. CBP components
Also the CBP components will be discussed in further detail.

CBP and View Modeling Tool
This component is used by the participating companies in order to define their process views based on their private processes. Furthermore this tool should support the overall definition of the CBP which uses the views.

CBP monitoring and analysis tool
This component can be used to monitor actual executions of CBP instances. It may furthermore support offline data analyses that has been stored during the CBP execution.

CBP Repository
A common repository is necessary that stores CBP data as well as execution data or process instances. Regarding the information about a process instance, this information derives from the process enactment engine for view processes.
5.4. Architecture Alternatives

The chapter above described architecture for a CBP enactment engine. However, it is also necessary to explain how such a CBP enactment engine can be integrated into the current ICT landscape of an organization. Providing a practicable integration solution of the CBP enactment architecture is very important for the CBP approach to be adopted and executed by all partners within a CBP scenario. Therefore ATHENA researchers have identified three different typical system landscapes.

I. The organization does not have a business process management system. Therefore an engine is needed that is capable of executing private processes as well as view processes (see left bar).

II. No internal process management system is available for private processes. Thus the view process engine has to interact directly with the applications (see middle bar).
III. The organization has a fully implemented internal process engine and it is not an option to exchange it. The process view engine has to be developed in a way that allows for integration with the existing internal engine.

5.5. Physical Architectures

There are two fundamental architectural principals for a physical architecture. One enables communication partners to interact directly with each other and is defined as unmediated or peer to peer communication. The other architectural principle includes a mediator and it is the mediator’s task to support the communication between partners. The architectural approach including the mediator is also named choreography, brokering, mediation. However in this booklet the term mediation will be used.

5.5.1. Peer to Peer Architecture

In a peer-to-peer (P2P) architecture, all partners respectively their business process management systems communicate directly with each other. This means all data has to be distributed over the partners. Furthermore, all CBP components need to be distributed between the partners as well. Communication in such an architecture takes place in a synchronous way. Synchronous means that communication between two partners is only possible, if both partners are available. Data necessary to communicate, like addresses, has to be known by the partners, because there is no...
central system. In such an architecture only point-to-point communication is possible. For example such architectures can be established in the internet, because it allows cooperation between two arbitrary partners.

5.5.2. Mediated Architecture

The second approach of realizing a physical architecture is through a mediator. A mediated architecture contains a central system called mediator. The function of the mediator is to mediate messages between partners. Therefore partners do not communicate directly, they communicate with the help of the mediator. The mediator receives all messages, resolves addresses and sends it to corresponding receivers. This results in an asynchronous communication, because sender and receiver never communicate directly with each other. To support an asynchronous communication, the mediator also includes message queues and message storages. Major task of the mediator is to handle messages. Additionally, a mediator can provide services, like storing of all exchanged messages. It is also possible to use a process engine as mediator. These functions do also show the complexity of a mediator which depends on the functions respectively services he provides.

If this architecture solution is used, the CBP components can be hosted by the mediator and the partners can retrieve necessary information from the mediator. The choice for the appropriate physical architecture depends on the business scenario and on the requirements of the partners. Consider the business scenario describing a market place for oil & gas. In this scenario the marketplace typically acts as a mediator since buyer and seller want to stay
anonymous. Thus makes it impossible for competitors to derive a potential shortage of the supply. Therefore the mediated approach is the appropriate physical architecture option and in this case a peer-to-peer approach is not applicable.

However, a peer-to-peer architecture distribution may be the best choice for the forecast integration scenario. In such a scenario supply chain partners (suppliers, OEMs, inventory managers, retailers and customers) collaborate in a supply network to fulfill customer orders. To be able to make strategic and operative decisions in all phases of the supply chain process the partners use predictions (forecasts) about important future developments in their network (e.g. future market demand, future market supply, performance of particular business transactions). As these forecasts are highly dependent on each other the partners collaborate closely to make the predictions. Thus, the peer-to-peer option is appropriate for this business scenario.
6. Detailed Architecture
The last section presents detailed architectures for executing cross-organizational business processes in three different internal landscape systems

6.1. View Process Engine

The ATHENA view process engine is capable of implementing the ATHENA CBP approach. This architecture embraces the execution of private processes and view processes in one engine. No additional engine is required for process execution. This approach is suited for organisations that are willing to set up and implement a new engine that is fully capable of executing the ATHENA CBP approach. Private processes can be defined and executed invoking internal services or applications. A view process can be defined hiding confidential information and communicating with the outside world.

The following components form the ATHENA View Process Engine:

- **Enactment Engine**
  An extended process engine that is capable of executing private processes through an invocation of internal applications and services. It executes process views and manages synchronization between private processes and view processes. Another task includes sending and receiving messages to and from partners as well as updating partners with relevant monitoring information.

![Figure 17 - View Process Engine](image-url)
- **Modelling Tool**
  A modelling tool is included that allows the creation of private, view and cross-organisational business processes.

- **Integrated Repository**
  An integrated repository is necessary which saves all processes. This includes the process models as well as the instances.

- **Event and Document Correlation**
  An event and document correlation component.

The ATHENA view process engine can be used in a mediated as well as in a peer-2-peer physical architecture. In a peer-to-peer distribution, each partner would run an ATHENA view process engine and the engines would communicate with each other as shown above. If a mediator is needed the engines would not communicate directly but through the mediator. The mediator would forward the messages and status updates between the partners. If total anonymity is needed and the partners should not be informed about the status of the other partners, this information can be suppressed by the mediator.

### 6.2. Direct Application Integration

The figure below shows an alternative architecture. This architecture refers to a scenario where no internal workflow management system is available for private process enactment and monitoring. The architecture for the direct application integration comprises the following specific building blocks:

- **Enactment Engine**
  An enactment engine for view processes that is capable of direct communication with internal applications via events. Furthermore the enactment engine shall execute process views including sending and receiving messages to and from partners.

- **View Process Repository**
  A view process repository that does only contain information related to the view processes. Imagine within the direct architecture integration private processes are not considered either as models or run-time instances.
**CBP Components**

The CBP components as described in the high-level architecture in chapter 6.3

The components for Private Process Modelling, Private Process Monitoring & Analysis and the Private Repository are not of relevance in this architecture alternative. The motivation for deploying the CBP enactment architecture is following strategic partners who are proposing it. Hence, there is a clear separation between internal processes and view processes that are modelled and monitored separately.

### 6.3. Internal Engine Integration

The third alternative for a CBP enactment architecture can be found on the figure below. In this case it is assumed that the organization already runs a full-fledged enactment engine for private business processes. Then CBP enactment architecture for internal engine integration comprises the following components:

- **The Interface Components**
  
  The interface components as they have been described in the high-level architecture
- **The CBP Components as**
  The CBP Components as described in the high-level architecture

- **A private process modelling tool**
  A private process modelling tool in which the internal private business processes are designed and modified.

- **Private Repository**
  A repository is needed to store the internal process models and instances

- **Internal Applications**
  A set of applications or services, which provide business logic

- **Enactment engine private processes**
  An enactment engine running the company’s private processes. This engine provides the hook at which the interface components are connected to the company internal components. It has to provide an appropriate interface for sending and receiving messages to and from the enactment engine for view processes. Furthermore, execution states have to be communicated between the two engines

- **Private process monitoring**
  An optional monitoring and analysis component for private processes
Figure 19 - Internal Engine Integration
VII Glossary

**CBP:**
A Cross-Organizational Business Process defines the interactions between two or more business entities. These interactions take place between the defined view processes and are defined as a sequence of message and/or other material input/output exchange.

**View Process:**
A View Process combines different Private Processes to an abstract level that enables companies to hide critical information from unauthorized partners.

**Private Process:**
Private Processes are internal to a specific organisation and are the types of processes that have been generally called workflow or BPM processes.
VIII. List of Literature

1. Champy, James: X-treme Business Reengineering, in:
   http://www.optimizemag.com/article/showArticle.jhtml?articleId=17700684&pgno=1. date of
   request: 19/08/2005
2. Schulz, Kartsen A.; Orlowska, Maria E.: Facilitating cross-organizational workflows with a
   workflow view approach in Date and Knowledge Engineering, Volume 51, 2004, Issue 1,
   pp. 109 – 147
3. Smith, Howard; Fingar, Peter: Business Process Management the third wave. Meghan-
   Kiffer Press, Tampa, FL, USA, 2002
4. Smith, Howard; Fingar, Peter; Carr, Nicolas G.: It Doesn't Matter--Business Processes Do:
   Kiffer Press, Tampa, FL, USA, 2003
PART B
Interoperability
Tools and Technologies
1. Installation of Maestro

Navigate with a file browser, i.e. Windows Explorer into the according Maestro folder. Double-click on *MaestroBPM_1.2.03.msi* and the setup wizard for Maestro pops up (see Figure 20). The setup wizard guides you through the installation. You can find the start icon of Maestro with your Windows Start menu.

![Screenshot Setup Wizard](image)

Figure 20: Screenshot Setup Wizard

2. Business Example

This description about how to create private processes, view processes, and cross-organisational business processes (CBP) with Maestro uses the following example process. Furthermore, the example below (see Figure 21) provides a basic overview of the interrelationships between private processes, View Processes, and CBPs.

Two partners are involved, Alice and Bob. It contains private processes from Bob and Alice, their view process as well as their agreed CBP in the middle. The private processes contain all relevant information about a certain business process, i.e. tasks, resources involved, decisions. Partners typically want to keep this information private and expose information to partners in a controlled way. Therefore, Bob and Alice create view processes to encapsulate their internal information. View processes are an abstraction of several private activities which are merged into a view task that is part of a view process. The semicircular double arrows in Figure 21 represent a relationship between the private process and view process. Maestro stores the dependencies and relationship between the private processes and view processes. This enables Maestro to identify and assign private activities to an according view activity and vice versa.

The middle process in Figure 21 represents the CBP. The CBP consists of interweaved view tasks of Alice and of Bob (Bob is marked blue in this figure).

This handbook continues with a step by step description from the explanation of the modelling features (3), modelling private processes (4) over the composition of view processes (5) up to the modelling of a CBP (6).
Figure 21: Introductory Business Example – relationships between Private Process, View Processes, CBP
3. Modeling Features in Maestro

Below you can find a screenshot of Maestro. Some areas are either marked or pointed to with a figure framed in a square. Those areas provide useful support during the modelling process. Areas can be added or removed via View -> Navigator, Layout Tools, etc.

![Screenshot Maestro](image-url)

1. Business Process Modelling Area

Number 1 indicates the business process modelling area. Within this area the actual modelling takes place.
## 2. Modelling Elements in Maestro

Maestro provides the following elements / notation for modelling:

<table>
<thead>
<tr>
<th>Modelling Notation</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Activity**       | The rectangle represents an activity.  
  - **Insert Activity** 
    In order to insert an activity into a business process, drag it from modelling element area into the drawing area (business process). Note, the left mouse has to be pressed.  
  - **Name Activity** 
    Each activity needs to be marked with a unique name. A name can be entered by double clicking on the rectangle symbol. |
| **Begin**          | The oval is a notation for coordinators.  
  - **Insert Coordinator** 
    Inserting works the same way as for activities.  
  - **Choose Operator** 
    Maestro offers several types of coordinators; the most popular are Begin, End, Choice, Merge, Fork, Synchronize (Sync). Just double click on the coordinator and a drop down menu allows appropriate selection. |
| Edges              | Edges connect activities and coordinators with each other.  
  You can draw edges by activating the toggle edge icon. After creation of edges deactivate the toggle edge icon to return to the regular modus.  
  - **Connect Activities and Operators** 
    See model control flow of the private process |
3. **Modelling Layout Features**

Before starting modelling it is useful to familiarize the user with some convenient layout tools. Maestro provides layout functionality (see Figure 23) which shapes a model automatically into a certain layout. Those tools support a clear and structured modelling and model appearance. Since layout is also a question of preferences, we suggest you to try out some of the different choices.

4. **Navigator**

As the name implies the Navigator allows easier navigation through the entire model. This tool is especially useful if large and long processes are modeled.

5. **Attributes**

The attributes section on the right allows regulating and adjusting of features of the used items. The most important features to mention are edition of appearances, like colors and fonts of single objects. Furthermore you can also enter values for certain variables in here (see also Operate the Choice Operator)
4. Modelling Private Processes

*Open a Business Process*
Before starting modelling you have to open a new Business Process (Private Process).

- **Open a Business Process**
  Select the white sheet symbol on the upper left corner or press [STRG + N] in order to open a new business process.

- **Enter a process name**
  (Compare Figure 24), here Bob

*Model control flow of the private process*

- **Connect Activities / Coordinators**
  Activities, Coordinators connect when putting one on top of the other (the little cross has to appear).

- **Insert new Activities, Coordinators within a Private Process**
  When you want to insert an activity or coordinator within an already existing process, just place the object into the according section. When a 2 square bracket appears, the edge is split and the activity or coordinator is placed within the middle.

- **Choose a Coordinator**
  Coordinators can first be put in with a default value and changed later. Synchronizer or merge coordinators after a split have to be placed on all activities to be merged or synchronized (one after another) to connect them (see also No. 4, 2 – modelling conventions)
2. Modelling Convention within Maestro

<table>
<thead>
<tr>
<th>Modelling Conventions</th>
<th>Description</th>
</tr>
</thead>
</table>
| [Diagram of Begin – End Constellation] | • **Begin – End Constellation**  
Each business process has to start with a Begin coordinator and to stop with the End coordinator. Thus the Begin and End coordinator enclose the actual private process. |
| [Diagram of Fork – Sync. Constellation] | • **Fork – Sync. Constellation:**  
Fork initiates a parallel split of a process. A parallel process can be consolidated with the coordinator Sync. (i.e. a Fork – Merge does not form a valid constellation) |
| [Diagram of Choice – Merge Constellation] | • **Choice – Merge Constellation**  
The Choice coordinator initiates a decision within the process. In order to consolidate the choice process again, the Merge coordinator has to be inserted. |
| [Diagram of Loop - Constellation] | • **Loop - Constellation:**  
A Loop is modelled by using the Merge – Choice Operator. |

! All other constellations will not lead to a valid model !
3. Operate the Choice Coordinator

In case a choice coordinator has been used within the process (compare introductory example Bob’s process), certain conditions have to be defined to operate this coordinator. Conditions must be set for the entire private process and also for the according edges coming out of the particular choice operator.

- **Set edge relevant data**
  The choice conditions within a business process are located on the edges coming out of a choice coordinator. Choice conditions allow the Choice coordinator to decide which path to follow for a certain attribute (which has been defined in a workflow schema)). However, select one edge after the other coming out of a Choice coordinator. For each out coming edge see the **Attribute area**. For ModelEdge, Expression, provide the following format: (variable==‘value’).

4. Save Processes

After you have modelled the processes you can save the models by choosing **File -> Save**.
5. Workflow Relevant Data

- **Global Data Repository (GDR)**

  The GDR is a container for all data objects used across different private business processes. It uses a file system for the storage of data objects. Data models are represented by different XML Schema documents which can be nested.

- **Naming Conventions**

  All data models are named after the first data element which references the “complexType” within them. Furthermore, to differentiate different types of data models the following conventions are required. WRDs are uniquely identified by private business process types where they can be used. The filename for each workflow schema must start with “WRD” such as “WRDOrderProcess.xsd”.

  ![Figure 26 Workflow schema example](image)

There are also attributes provided which are filled automatically at runtime such as the name of the current activity or the instance id of the coalition process. This information can be used for correlating different processes at runtime. **Error! Reference source not found.** gives an example how this workflow information has to look like in order to be automatically filled in at runtime.

Important is that you use the same names as in the examples because only following XPath expressions are supported at the moment:

- “//WorkflowInformation/Activity/ActivityName”
- “//WorkflowInformation/CorrelationInformation/CoalitionWorkflowModelExternalId”
- “//WorkflowInformation/CorrelationInformation/CoalitionWorkflowInstanceId”
- “//WorkflowInformation/CorrelationInformation/CoalitionDependencyModelExternalId”
Overview:

- The XML schema filename which contains the message has to start with “WRD”, e.g. “WRDData.xsd”
- In case the schema references other external schema files the import statement has to be used and the files have to be available in the GDR repository
- The service XML schema has to contain exactly one child element which is called the top element, e.g. “WRDOrderData”
- For correlation the workflow information (compare Error! Reference source not found.) should be included in the schema definition

- Assign Global Data Repository (GDR)

Before you can assign new workflow schemas to a private process make sure that the GDR settings are correct and the directory contains valid XML schemas.

Click in the Maestro menu on Tools → Preferences… and select the Files and folders tab.
• **Set workflow relevant data**

Process relevant data can be set by opening the context menu (right mouse click) and selecting workflow relevant data. Make sure you have not selected any item within the business process! Define a new schema. Now you have assigned a workflow schema for the entire workflow.
6. Partner Management in Maestro

The partner management in Maestro allows you to comfortably administrate partners for Maestro and Nehemiah. In order for the Partner Management to work, the Nehemiah server needs to be running (for an explanation on how to start Nehemiah, please refer to the Nehemiah Handbook). You need to make sure that you assign partners before you start creating views and CBPs.

- **Assign Existing Partner to a Process**
To assign partner to a process, you need to open the partner management area. This is done via View -> Nehemiah. Clicking on Nehemiah shows you all partners that are currently saved in the Nehemiah repository. A partner can be chosen and dragged and dropped into the modelling area (see Reference source not found.). Please note, the box with “Bob” will disappear once you release the mouse. If you do so, you can check via the process attributes, whether the partner has been assigned properly.

![Figure 31 Assigning partners to a process](image)

- **Managing Partners**
New partners can be added, deleted and modified. To add a new partner, right click on the partner folder and choose “Add Partner”. You can then specify the partners name, Id and swimlane colour,
To delete a partner, right click on the partner and choose delete. Please note, you can only delete partners if they are not assigned to any processes currently saved in the Nehemiah repository. Via a right click you can also modify a partner.
7. Inside Out Modelling of View Processes

1. Business Process Analysis Tool
Maestro provides the functionality with several features for the modelling of View Processes and CBPs. The tool is called **Business Process Analysis** (compare Figure 33).

   - **Open Business Process Analysis**
   This tool can be found under **Tools – Business Process Analysis** in the menu bar.
   Business Process Analysis is a useful tool for modelling of View Processes and cross organizational business processes.

2. Create Intermediate View Processes, Inside-Out Modelling
The first step towards a CBP is to model inside out intermediate view processes. This modelling approach is called inside-out modelling since start with the internal private processes.

   - **Create an intermediate View**
   Open the tool Business Process Analysis and select **Create an intermediate view process from a private process** (see also Figure 37). Maestro will generate an identical copy of the private process.
- **Select Activities**

View processes are a combination of several private activities for purpose not to reveal privacy requirements. To model those view processes select the according activities you want to combine (see Figure 34).

![Select Private Activities](image)

**Figure 34: Select Private Activities**

- **Formation of a valid Group**

If coordinators are included in the selection it is necessary to check that the selection forms a valid group. Coordinators have to be corresponding within the list (see also modelling conventions). I.e. an invalid group would be if a Choice coordinator is included in the selection but the corresponding Merge Coordinator has been left out.
- **Group private tasks**

  Open the Business Process Analysis Tool and select *Group private tasks into a view task* (see Figure 35) Maestro automatically groups those activities into a View Process (see Figure 36).

- **Result / Rename View Process**

  As you can see from Figure 36 it is not possible to recognize any single activities or coordinators from the underlying private process, except the names. Since the new created view process (see Figure 36) still contains the identifiers of the grouped activities we renamed this view process into View Process.
Figure 36: View Process – as combination of single activities provided from figure 9
8. Inside Out Modelling of Cross-Organisational Business Processes (CBPs)

After the intermediate View Processes have been created it is now time to model the CBP. This has to be done jointly by both business partners. To model the CBP Business Process Analysis needs to be selected again.

1.) Create an Intermediate CBP

Based on the intermediate view processes we create an intermediate CBP.

- Prepare intermediate CBP
  
  Select *Create an intermediate coalition process from view process* (see Figure 37) from *Business Process Analysis*.

- Select appropriate Views
  
  The following window pops up (see Figure 38). It allows you to select the appropriate view processes you want to interweave into the CBP. Related to our introductory example, choose AliceView' and BobView' and hit generate.
• **Enter a Name for the CBP**

You are now asked to enter a name for the CBP (see Figure 39). Either leave the default or enter an appropriate name of choice (in the example we used AliceBob CBP). After having done that step you are able to model the CBP.

2.) **Model Cross Organizational Business Processes (CBP)**

The next model reproduces both view processes. That allows modelling the CBP by linking up these View Processes together. The View Processes can be linked up by activating the *toggle edge creation* icon within the shortcut bar (see Figure 40).

• **Activate Toggle Edge Symbol and model CBP**

After activating place the mouse arrow on a view process task. The mouse pointer changes into a cross symbol. Now, keep mouse button pressed and link the view process task of the partners with each other (see Figure 41). Reiterate this connection creation in both directions until the desired CBP is achieved.
9. Creating Final Views of View Processes and the Cross-Organisational Business Process

After modelling of the intermediate CBP the last step is to create the finalized views of the CBP and the view processes. Again the Business Process Analyzer () is needed.

- **Create finalized CBP from Intermediated CBP**

  Click *Create a finalized coalition process with messaging tasks (figure 17)*. Maestro automatically sets sender and receiver tasks. For more convenience Maestro also adjusts and suggests a new optical layout for the CBP (see figure 18)

  *Receiver Tasks are necessary to depict kind and location of interaction and furthermore to ensure execution at runtime*
- **Create final view processes from Intermediate view processes**
  
The last step of the modelling is to create the final View Processes. Again open the Business Process Analysis tool and choose the very last option, *Create finalized view processes from finalized coalition process* (figure 19).

Again Maestro automatically places Sender and Receiver activities within the view process of each partner. Thus it enables the partner to solely see his interaction points with the CBP. The final view process of Alice can be seen below (figure 20). The finalized view processes and the CBP can be stored choosing *File – Save.*
In case you want to know more about internal and external services please read the Gabriel handbook. The differences between those services are explained.

- **Check Gabriel settings**

Before you can assign services from the Gabriel repository make sure that the settings are correct and the Gabriel Engine is up and running.

Click in the Maestro menu on Tools → Preferences... and select the Runtime tab.

Make sure that the URL for the Gabriel service client is set to the correct server and apply the changes (compare Figure 46).
Assign internal services

Internal services can be assigned to an activity on two ways. Either you use the context menu which pops up with a right-click on the respective activity and choose “Assign new Internal Service” (see Figure 48) or you can drag and drop the internal service profile from the Gabriel window into the workflow (see Figure 49).

Assign external services

External services can be assigned in a finalized coalition process on the receiver or the sender nodes where the receiver nodes represent the incoming endpoints on your process and the sender nodes represent the outgoing endpoints to your partner’s process (compare Figure 50).
• **Message mapping**

Once you assigned internal or external services to a node you can define the mapping between the workflow and the service message. To open the mapping dialog you have to open the context menu via right-click on the respective node and select “Map service attributes” (compare Figure 51).

In the mapping window you will see the service message on the left and the workflow message on the right side. To map two attributes you have to select those on both side and click the “>” or “<” button. The “>” sign indicates that you map values from the left to the right and the “<” sign maps from right to left (compare Figure 52).

An external receiver message can only be mapped to the workflow data and on the other hand an external sender message can only be mapped from the workflow to the service message. In case of an internal service the mapping directions depends on the request or the response message.

**Note:** There is currently no validation of attribute type checking!
Figure 52: Mapping internal service
Deploy Business Processes to Nehemiah

- **Check Nehemiah settings**

Before you can save the processes to the Nehemiah Engine make sure that the settings are correct and the Nehemiah Engine is up and running.

Click in the Maestro menu on Tools → Preferences... and select the Runtime tab.

Make sure that the URL for the Nehemiah service client is set to the correct server and apply the changes (compare Figure 22).

![Preferences dialog](image1)

**Figure 54: Maestro preferences**

- **Deploy process on Nehemiah Engine**

To deploy your designed processes click on “Runtime” in the Maestro menu and select the “Save” button.

![Save dialog](image2)

**Figure 55: Save**

The following dialog window will appear and you have to select the processes you want to deploy to Nehemiah. In our case we select all processes belonging to our business example (compare Figure 24).
XI. Handbook Nehemiah
1. Business Example

This description about how to run private processes, view processes, and cross-organisational business processes (CBP) in Nehemiah uses the following example process. Furthermore, the example below (see Figure 56) provides a basic overview of the interrelationships between private processes, View Processes, and CBPs.

Two partners are involved, Alice and Bob. It contains private processes from Bob and Alice, their view process as well as their agreed CBP in the middle. The private processes contain all relevant information about a certain business process, i.e. tasks, resources involved, decisions. Partners typically want to keep this information private and expose information to partners in a controlled way. Therefore, Bob and Alice create view processes to encapsulate their internal information. View processes are an abstraction of several private activities which are merged into a view task that is part of a view process. The semicircular double arrows in Figure 56 above represent a relationship between the private process and view process.

The middle process in Figure 56 represents the CBP. The CBP consists of interweaved view tasks of Alice and of Bob (Bob is marked blue in this figure).

Figure 56: Introductory Business Example – relationships between Private Process, View Processes, CBP
2. Prerequisites

Before you are able to run processes in Nehemiah they have to be modelled and deployed with Maestro. Further information is available in the Maestro Handbook (see Handbook for Maestro for BPM 1.3.50).
Also you have to make sure that you installed a SVG plug-in for your browser to be able to display workflows properly.

3. Installation Guide

Navigate with a file browser, i.e. Windows Explorer into the according Nehemiah folder. Double-click on the installer file and the setup wizard for Nehemiah pops up. The setup wizard guides you through the installation. You can find the start icon of Nehemiah in your Windows Start menu.
If you have downloaded a zip file, simply extract the zip file in a local directory on your machine. No installation routine is required in this case.

4. Nehemiah Engine

In order to open the user interface make sure the Nehemiah server is up and running. To start the server you have to open the server.cmd file in your <Nehemiah-Home>/bin directory (e.g. C:\usr\nehemiah-3.2\bin\server.cmd).
Once you started the Engine you are able to reach it under the URL http://<server>:<port>/nehemiah for example http://localhost:1080/nehemiah.
If the connection is successful the Nehemiah start page is loaded (compare Figure 57)
On the start page you have several options which will be explained in the next chapters.
**User Interface**

The process representation is based on SVG (Scalable Vector Graphics). SVG is a XML-oriented language to describe two-dimensional and scalable graphics.

Colour coding is used on the execution pages. Here you are able to see the design of the processes which you want to start. In the zoom menu you can choose the size of the design model and furthermore you can execute the process with the start button in the top-left corner (compare Figure 58).

![Diagram](image)

**Figure 58: Process execution (1)**

Once you started the process you will realise the “Begin” coordinator will change its colour to green which means this step is completed. The next activity “B1” will be light blue which indicates that this is the next task which can be started. The full colour legend is displayed on the bottom of the page (compare Figure 59).
If you click with your cursor on “B1” this activity will change its status depending on the “Diagram click behaviour” which you can change in the upper menu.

You have three possibilities to set the click behaviour (compare Figure 60).

- **Change status to completed**
  The first setting sets the status of the activity to completed which means the current activity changes its colour to green and it successors change their colour to light blue (compare Figure 61).
The second behaviour changes the status of the current activity to the next usual status. Let's say the current status of activity “B2” is “Not Started” than the next normal status will be “Running”. After “Running” the status will be completed and the successors are instantiated and so forth.

- **Popup status change window**

Click behaviour number three opens a popup window if you click on the current activity (compare Error! Reference source not found.).

You can assign a new status for the current activity by clicking one of the buttons. If you use workflow attributes you can also change the values for this attributes under step 1. This is especially useful if you have “Choice” coordinators and want to specify the path which the process should follow. You also enter workflow relevant data for activities that are not executed by a web service but by a user.

To open the window for checking and editing the workflow relevant data click the “Open” link. You then see a window with a structured view of the workflow relevant data (see Figure 63). All data elements that have already been set are filled. You can update these elements and insert values for data elements that have not been set so far. By clicking the “Save” button on the bottom of the form (see Figure 64) you save the data. The option “Save as default” allows you to set default values that are set automatically every time you start a new process. This option can be used for debugging, e.g. to set data values for choice nodes.
Change Activity Instance Status

Id: 152
Current Status: Not Started

Step 1: Modify attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>workflowName</td>
<td>string</td>
<td>EADS-change-mgmt-pf</td>
</tr>
<tr>
<td>schemaName</td>
<td>blob</td>
<td>Open</td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td>Enter user ID and pass</td>
</tr>
</tbody>
</table>

Step 2: Choose new status

- Running
- Aborted
- Terminated

Figure 62: Status Dialog

SAP RESEARCH

Nehemiah

WRDData

<table>
<thead>
<tr>
<th>attribute</th>
<th>value</th>
</tr>
</thead>
<tbody>
<tr>
<td>proposedSolution</td>
<td></td>
</tr>
<tr>
<td>finalSolution</td>
<td></td>
</tr>
<tr>
<td>evaluationResults</td>
<td>update</td>
</tr>
<tr>
<td>productId</td>
<td>34</td>
</tr>
</tbody>
</table>

Figure 63: Form for workflow relevant data
Figure 64: Saving workflow relevant data

**Standard – Execute normal Business Processes**

If you want to execute and simulate private processes from one partner without coalition your have to select *Standard* on the start page. In our example you will see two private processes; one named “Private_Process_Bob” and the other “Private_Process_Alice” (compare Figure 65).

To run one process you have to select the start icon 🛠️. For more information about the properties see chapter 0.
The next page in Nehemiah will show the design of the private process which you just selected (compare Figure 58).

**CBP (by process) – Simulate a distributed process environment**

In the Coalition execution you can simulate the Cross Organisational Business Process running on several partners. Under “CBP (by process)” you can simulate the whole business scenario with all partners which are involved in the process. The purpose of the simulation process is to ignore the web services and user tasks assigned to each activity and just run the CBP with generic activities.

If you want to start the coalition process you first need to select the “Initiator” (e.g. Alice) for the scenario (compare Figure 66).

Now the design views for the selected partner (e.g. Alice) are displayed (compare Figure 67). You should see a private process as well as a process view and a coalition workflow. The second and third diagram maybe hidden and can be made visible with the buttons on the page.
See chapter 0 on how to execute the process.
The difference to executing a private process is that in the coalition workflow one partner cooperates with another. Therefore you also see the sender and receiver plugs of each process and how they are linked together. You can complete each activity until a receiver node is reached (compare Figure 68).
When you move the cursor over one activity you will notice that every activity belonging to the same group and the group itself are displayed with a red border. This helps to keep track which activities belong to the same group of the CBP.
To continue the coalition process you have to wait until the relevant activities on the partner’s process are completed. This is done by going back to the selection screen (compare Figure 69) and select “View Instances”.

Figure 68: Coalitions Execution - Partner: Alice (2)

Figure 69: CBP (by process) - View Instances
Next you need to choose the relevant partner role (e.g. Bob, compare Figure 70). The coalition properties of the second partner (Bob) are displayed and you can open the specific process you want to execute (compare Figure 71). This opens the coalition workflow of your selected partner and you can execute his activities in the same way as you did it with the initiator.

Choose your role: Alice (stop role)

Figure 70: CBP - Role Selection

CBP Properties (partner: Bob)

<table>
<thead>
<tr>
<th>Id</th>
<th>Name</th>
<th>Other Partners</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AliceBobCBP Alice</td>
<td></td>
</tr>
</tbody>
</table>

CBP View Instances

<table>
<thead>
<tr>
<th>Started</th>
<th>Instance Id</th>
<th>Process View Name</th>
<th>Open</th>
</tr>
</thead>
<tbody>
<tr>
<td>26/11/2005 10:04 AM</td>
<td>8</td>
<td>View_Process_Bob</td>
<td></td>
</tr>
</tbody>
</table>

Figure 71: CBP Properties for partner Bob

**CBP (by partner role) – Be a partner in a distributed process environment**

Unlike the “CBP (by process)” view the “CBP (by partner role)” one offers only one partner the possibility to maintain his own processes rather than give access to every role involved in the scenario.

Therefore the first step you have to do is to choose with which partner you want to proceed (compare Figure 70).

The next steps are similar to the CBP (by process) view. Clicking on “View Instances” (compare Figure 69) brings you to the instantiated processes (compare Figure 71) where you can open the one you are looking for.

The difference in this coalition view is that service calls and user task are actually triggered. That means that applications and web services which were modeled in Maestro are invoked and the messages are sent along the process.
Configuration Management - Do this before anything else

In the Configuration Management you define the settings for the JMS (Java Message Service) Server and you can clear the Nehemiah repository. The latter deletes all processes from the database but it does not affect the partners you have defined in Maestro.

**Act as JMS Server:**
- Yes

**JMS Server Host:**
- P126072

**JMS Server Admin Port:**
- 16010

**JMS Server JNDI Port:**
- 16400

**Save**

**Database Management**

Clear database (Removes all processes and related information from the database. Partners are not affected):

**Clear**

**Deleting Processes**

Besides clearing the whole Nehemiah repository as described in Section 0 you can selectively delete CBPs for particular partners. This step includes deletion of the related view processes and private processes.

You find the delete button on CBP properties page. You reach this page by clicking on the name of the CBP in the CBP list of the partners (see Figure 73). You can then delete the CBP by clicking the delete button (see Figure 74).
Figure 73: Select CBP properties view

CBP Properties (partner: EADS)

<table>
<thead>
<tr>
<th>Id</th>
<th>Name</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>change-mgmt-CBP</td>
<td></td>
</tr>
</tbody>
</table>

Figure 74: Delete a particular CBP

Views

<table>
<thead>
<tr>
<th>Id</th>
<th>Name</th>
<th>Partner(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>EADS-change-mgmt-ppView</td>
<td>EADS</td>
</tr>
<tr>
<td>6</td>
<td>Landing-Gear-Provider-change-mgmt-ppView</td>
<td>Landing Gear Provider</td>
</tr>
</tbody>
</table>

Diagram
Worklist

Worklists can be opened on several pages using the “View Worklist” button. A worklist will show the open activities for one partner. From here you can also change the status and set the attributes of the current activities.

Properties

For each of the three processes (private, abstract and coalition) there is the possibility to show their properties. All tasks, partners, attributes or dependencies belonging to one process are displayed on this page (compare Figure 76)
4. Role mapping

Currently the role names (e.g. Bob or Alice) for Nehemiah are hard coded and are not transferred from the design model. In Maestro you assign an ID number for each partner and this number is mapped to a partner name in Nehemiah. To be able to save a workflow on the Nehemiah repository, the mapping has to be defined in the file `nehemiahPartners.properties` which can be found under `<Nehemiah-Home>/conf` (e.g. `C:\usr\nehemiah-3.2\conf`). Figure 77 shows the mapping for our example process. Once you included all your partners you have to execute "ant init-db" in your `<Nehemiah-Home>` directory.
5. Running Nehemiah on different computers

If partners want to run their own Nehemiah engines which can communicate which each other they have to agree on which server the JMS server is running. Furthermore the private process of a partner is only deployed on his own Nehemiah engine. This means that every partner saves his own private process as well as all intermediate views from all partners and of course the coalition workflow. In our example partner Bob will not deploy the private process of Alice (compare Figure 78).

![Image of workflows deployed by partner Bob](image)

Figure 78: Workflows which are deployed by partner Bob

The partner (e.g. Bob) who runs the JMS server has to configure Nehemiah in the following way. In the configuration management (compare 0) the property “Act as JMS Server” has to be set to “Yes”. In addition he enters “localhost” or his computer name as the “JMS Server Host” and specifies the port settings.

All this information has to be communicated to all relevant partners. For example Bob has to tell Alice about his computer name and on which ports the JMS server is running.
Configuration Management

Act as JMS Server: Yes
JMS Server Host: localhost (Your hostname is: QKAD00142107A)
JMS Server Admin Port: 16010 (Default is 16010)
JMS Server JNDI Port: 16400 (Default is 16400)

Figure 79: Partner Bob runs JMS server

All other partners need to change the “JMS Server Host” to point to the computer name of their agreed JMS server. They have to change the property “Act as JMS Server” to “No” and change the port settings to the correct ports of the partner who runs the JMS server (compare Figure 80).

To continue our scenario, Alice uses the information delivered by Bob and enters Bob's computer name “QKAD00142107A” in the “JMS Server Host” field as well as the corresponding port settings.

Configuration Management

Act as JMS Server: No
JMS Server Host: QKAD00142107A
JMS Server Admin Port: 16010
JMS Server JNDI Port: 16400

Figure 80: Partner Alice uses JMS server running on Bob's machine

Once all Nehemiah engines are up and running the CBP scenario is executed like described in the previous chapter (compare chapter 0).